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Disclaimer 
This code may be used for any non-commercial and commercial purposes in a 

compiled form. The code may be redistributed as long as it remains unmodified and 

providing that the author names and the disclaimer remain intact. This code is 

provided without any guarantees. We cannot be held responsible for any damage or 

loss of time it may cause.  

This license governs use of the accompanying software. If you use the software, you 

accept this license. If you do not accept the license, please do not use the software. 

Oracle Binary Code License Agreement for the Java SE Platform Products and JavaFX 
Oracle America, Inc. ("oracle"), for and on behalf of itself and its subsidiaries and affiliates under common control, is 
willing to license the software to you only upon the condition that you accept all of the terms contained in this binary 
code license agreement and supplemental license terms (collectively "agreement"). Please read the agreement 
carefully. By selecting the "accept license agreement" (or the equivalent) button and/or by using the software you 
acknowledge that you have read the terms and agree to them. If you are agreeing to these terms on behalf of a 
company or other legal entity, you represent that you have the legal authority to bind the legal entity to these terms. If 
you do not have such authority, or if you do not wish to be bound by the terms, then select the "decline license 
agreement" (or the equivalent) button and you must not use the software on this site or any other media on which the 
software is contained. 

1. Definitions. "software" means the software identified above in binary form that you selected for download, install or 
use (in the version you selected for download, install or use) from oracle or its authorized licensees, any other 
machine readable materials (including, but not limited to, libraries, source files, header files, and data files), any 
updates or error corrections provided by oracle, and any user manuals, programming guides and other 
documentation provided to you by oracle under this agreement. "general purpose desktop computers and servers" 
means computers, including desktop and laptop computers, or servers, used for general computing functions under 
end user control (such as but not specifically limited to email, general purpose internet browsing, and office suite 
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productivity tools). The use of software in systems and solutions that provide dedicated functionality (other than as 
mentioned above) or designed for use in embedded or function-specific software applications, for example but not 
limited to: software embedded in or bundled with industrial control systems, wireless mobile telephones, wireless 
handheld devices, kiosks, tv/stb, blu-ray disc devices, telematics and network control switching equipment, printers 
and storage management systems, and other related systems are excluded from this definition and not licensed 
under this agreement. "programs" means (a) java technology applets and applications intended to run on the java 
platform, standard edition platform on java-enabled general purpose desktop computers and servers; and (b) javafx 
technology applications intended to run on the javafx runtime on javafx-enabled general purpose desktop computers 
and servers. “commercial features” means those features identified in table 1-1 (commercial features in java se 
product editions) of the java se documentation accessible at 
http://www.oracle.com/technetwork/java/javase/documentation/index.html. “readme file” means the readme file for 
the software accessible at http://www.oracle.com/technetwork/java/javase/documentation/index.html. 

2. License to use. Subject to the terms and conditions of this agreement including, but not limited to, the java 
technology restrictions of the supplemental license terms, oracle grants you a non-exclusive, non-transferable, limited 
license without license fees to reproduce and use internally the software complete and unmodified for the sole 
purpose of running programs. The license set forth in this section 2 does not extend to the commercial features. Your 
rights and obligations related to the commercial features are as set forth in the supplemental terms along with 
additional licenses for developers and publishers. 

3. Restrictions. Software is copyrighted. Title to software and all associated intellectual property rights is retained by 
oracle and/or its licensors. Unless enforcement is prohibited by applicable law, you may not modify, decompile, or 
reverse engineer software. You acknowledge that the software is developed for general use in a variety of 
information management applications; it is not developed or intended for use in any inherently dangerous 
applications, including applications that may create a risk of personal injury. If you use the software in dangerous 
applications, then you shall be responsible to take all appropriate fail-safe, backup, redundancy, and other measures 
to ensure its safe use. Oracle disclaims any express or implied warranty of fitness for such uses. No right, title or 
interest in or to any trademark, service mark, logo or trade name of oracle or its licensors is granted under this 
agreement. Additional restrictions for developers and/or publishers licenses are set forth in the supplemental license 
terms. 

4. Disclaimer of warranty. The software is provided "as is" without warranty of any kind. Oracle further disclaims all 
warranties, express and implied, including without limitation, any implied warranties of merchantability, fitness for a 
particular purpose or noninfringement. 

5. Limitation of liability. In no event shall oracle be liable for any indirect, incidental, special, punitive or consequential 
damages, or damages for loss of profits, revenue, data or data use, incurred by you or any third party, whether in an 
action in contract or tort, even if oracle has been advised of the possibility of such damages. Oracle's entire liability 
for damages hereunder shall in no event exceed one thousand dollars (u.s. $1,000). 

For the complete license please read the license.txt file found in the application root directory. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.oracle.com/technetwork/java/javase/documentation/index.html
http://www.oracle.com/technetwork/java/javase/documentation/index.html
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1. How to install ColloidFit 
 

The installation of ColloidFit is pretty straightforward because it is natively 

packaged with the necessary java runtime environment for both “Windows” and “Mac 

OS X” operating systems. Therefore, the user does not need to have java runtime 

environment already installed. All the necessary libraries required for ColloidFit++ to 

run are already included in the distributed installers. Just double click the respective 

installer, ColloidFit.msi for windows operating systems and ColloidFit++.dmg for 

Macintosh systems and execute the easy to follow installation steps (see Figure 1.1 

and Figure 1.2, respectively). For any installation questions please visit the 

troubleshooting section of the current manual. The minimum requirements for an 

operating system to be compatible with ColloidFit++ can be found in Table 1. 

 

 

Figure 1.1. Installer in Windows 

 

 

Figure 1.2. Installer in Macintosh 
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Table 1.1 System requirements 
 

ColloidFit++ minimum OS requirements: 

Processor Minimum Intel Core i3  or similar 
Recommended Intel Core i7  or similar 

RAM More memory allows even larger graphs, but runs the risk of inducing 
larger Garbage Collection operations. 

Minimum 2GB  
Recommended 16—32GB or more  

Available Hard Disk 
Space 

Minimum 10GB SATA  
Recommended 100GB SSD w/ SATA 

Operating System 
Windows 

 Windows 10  
 Windows 8.x (Desktop) 
 Windows 7 SP1 
 Windows Vista SP2 
 Windows Server 2008 R2 SP1 (64-bit) 
 Windows Server 2012 and 2012 R2 (64-bit) 

Mac OS X 

 Intel-based Mac running Mac OS X 10.8.3+, 10.9+ 
 Administrator privileges for installation 
 64-bit browser 

See supported Java 8 System Configurations for information about 
supported platforms, operating systems, desktop managers, and 
browsers.  

 

CD-ROM or DVD-
ROM Drive 

Optional 

Video 1280 x 800, 256 colors (recommended: 1920x1080, true color 32bit) 

Mouse Microsoft Mouse or Compatible pointing component 

 

 

  

 

 

 

 

 

http://www.oracle.com/technetwork/java/javase/certconfig-2095354.html
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2. About ColloidFit 
 

The ColloidFit is an autonomous multipurpose fitting software for colloid fate 
and transport phenomena in porous media. The software is accompanied by an easy 
to use graphical user interface. ColloidFit can simulate the migration of colloid or 
biocolloid particles in one-dimensional water saturated, homogeneous porous media 
with uniform flow, accounting for non-equilibrium attachment onto the solid matrix. 
ColloidFit is using the state of the art fitting software, Pest. Therefore, ColloidFit is 
able to estimate unknown model parameters and to calculate the associated 95% 
confidence internals. 

Pest is a model-independent parameter estimation software, which can adjust 
model parameters or excitation data, so that the discrepancies between the pertinent 
model-generated numbers and the corresponding measurements are reduced to a 
minimum. More information related to the Pest software can be found at the official 
web page: http://www.pesthomepage.org/ 

 Furthermore, given the advanced capabilities of ColloidFit, updated simulation 
results are provided graphically during the fitting process, so that the user can have a 
critical insight about how the various coefficient values affect the fitting process. Also, 
the model parameters, together with all necessary input and output information are 
displayed on the graphical interface. The fitting process may stop and resume at any 
point, upon user request. At the end of each parameter estimation-run, the best-fitted 
parameter values are displayed together with their 95% confidence intervals. Finally, 
extra attention is given to the way the raw data are manipulated by ColloidFit, so that 
data columns displayed on the user interface can be directly copied and pasted to 
Excel spreadsheets, by simple cut-copy-paste actions.  It is worth mentioning here 
that in order to maximize the compatibility with the various operating systems, when 
pasting raw data to ColloidFit, the number format can use either “comma” or “dot” as 
decimal separators. There is no distinction between these two. However, when 
copying from ColloidFit the exported number format will use Operating Systems 
decimal separators.   
 

2.1. Quick walk through 
For a quick tour of how ColloidFit can be used, a relatively simple fitting 

example is presented next.  

When ColloidFit is executed for the first time, Figure 2.1 should be visible to the 

user. This is the step-by-step “User Guide” that allows for an assisted interaction with 

ColloidFit.  Given that this is the first execution, the “Create New Project” button 

should be clicked. This gives the user the opportunity to create a new ColloidFit 

project file, and customize its name and position within the system. 

 

 

http://www.pesthomepage.org/
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Figure 2.1. The User Guide, Step 1: welcome screen. 

 

Creating a project file is a necessary step for any single simulation or fitting 

process. In order to protect the user, ColloidFit shows multiple warnings for most of 

its functions when no project file is available. A project file allows the user to save the 

current work, and reload it at a later time. All ColloidFit project files use the extension 

“.cfit”, for both Windows and Macintosh operating systems.  Keep in mind that the 

project file name should not be longer than 20 characters. This restriction 

considerably reduces the possibility that there will not be enough space available in 

the user interface to display the complete file name. 

After creating a new project file name, the user should click the “Next” button 

located at the bottom right corner (see Figure 2.1). This operation allows the user to 

select one of the four available simulation models. Here, for the needs of this simple 

example, the “Virus transport” model is selected (see Figure 2.2). Each of the 

available models will be described thoroughly in subsequent sections of this manual 

(see sections §4.1-4.8).  
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Figure 2.2. The User Guide, Step 2: Available models.  

After selecting the desired model, here the “Virus transport” model, by clicking 

the “Next” button the display presented in Figure 2.3 is shown. ColloidFit supports 

two different colloid/biocolloid source configurations: (1) Instantaneous and (2) Broad 

pulse source (for detailed description of the sources see section §4). To continue 

with this tutorial, please select “Instantaneous source” and then click on the “Next” 

button, in order for Step 4 display to appear, as shown in Figure 2.4.  

 

 

 

 

 

 

 

 

 

 

 

 

  

  Figure 2.3. The User Guide, Step 3: Available source configurations. 
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 Figure 2.4. The User Guide, Step 4: Time and Coordinate information. 

 

The selected “Virus trasnport” model requires that the user enters three 

different data lists: (1) the sample collection times should be provided under the 

header “Time (t)”; (2) the sample collection x-coordinates should be provided under 

the header “Length (x)”; and (3) the collected sample concetrations should be 

provided  under the header “Cexp (t,x)”.  An example of the three filled lists of data is 

shown in Figure 2.5. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 2.5. The User Guide, Step 4: Time and Coordinate information. Columns are 

now filled with required experimental data. 
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Note that, data can be inserted or editted in the table shown in the Step 4 

display, either by double clicking onto individual shells, or by simply editing the “T:”, 

“X:” and “C:” textboxes located just below the table and then clicking the “Add” button 

to the right (see Figure 2.5). At this stage, by clicking the “Next” button the user 

reaches the final step, “Step 5”, which is displayed in Figure 2.6. Here, the initial 

parameter values should be inserted for all the parameters required by the selected 

model, which are already defined in Steps 2 and 3. The various parameter symbols 

displayed are defined in subsequent sections (§4.1-4.7). Furthermore, each 

parameter displayed in Figure 2.6 is followed by a check box, indicating whether this 

parameter should be fitted or not. In general, it is a good practice to fit two 

parameters at a time, and under no circumstances fit more than three (Katzourakis 

and Chrysikopoulos, 2014).   

 

 

 
 

Figure 2.6. The User Guide, Step 5: Initial parameter values and fitting status. 

When all parameter textboxes are filled with valid numerical values (see Figure 

2.7), by clicking the “Finish” button, the parameter values undergo a final quality 

check and subsequently they are transferred to the main ColloidFit user interface. At 

this point, many warnings may appear if something is wrong. For example, warnings 

may show if an invalid project name was inserted by the user, or if none of the model 

parameters were selected as fitted parameters, and so on...  
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Figure 2.7. The User Guide, Step 5: Initial parameter values and fitting status. 

After the validation process is successfully completed, the main ColloidFit 

interface is displayed (see Figure 2.8). Initially, this interface consists of an empty 

plot area with a set of blank parameter text-boxes. In this “Graphing” tab the user 

gets updates about the fitting progress. Note that in the display presented in Figure 

2.8 all text-boxes are empty because the fitting process has not been initiated yet. 

 

 
Figure 2.8. Main ColloidFit interface produced by the User Guide: Graphing tab. 
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Clicking on the “Fitting” tab, which is located at the top left corner (see Figure 

2.8), a new page is displayed (see Figure 2.9), that holds all the experimental data 

provided to the User Guide up to this point.  This is a compact and intuitive interface 

that allows the user to review, and edit if necessary, all the necessary information 

associated with the current fitting process.  More about the fitting tab can be found in 

section §3.2. 

 

Figure 2.9. Main ColloidFit interface produced by the user Guide: Fitting tab. 

Finally, the user now can press the “Start Fitting” button, which is located at the 

bottom right corner of the Fitting tab (see Figure 2.9). This action initiates a validation 

check, in order to make sure all data were properly inserted (i.e. no missing 

parameters, no unexpected zeroes, the number of experimental concentrations and 

time entries are equal, at least one of the model parameters is selected to be fitted, 

etc), and subsequently begins the fitting procedures. At this point, ColloidFit displays 

a new page (see Figure 2.10) with both the experimental data (orange circles), and 

splines of the current parameter simulations (blue curve).  After a sufficient number of 

fitting iterations, the best-fitted parameters are found and displayed (see Figure 

2.11). In this case, the fitting process is finished successfully. The total number of 

model simulations used is shown at the top right corner of the current display (see 

Figure 2.11). For the present illustrative example, the value 75 is shown, indicating 

that the complete fitting process required seventy-five model simulations.  
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Figure 2.10. Main ColloidFit “Graphing” tab: Fitting procedure in progress. 

 

 

Figure 2.11. Main ColloidFit “Graphing” tab: Fitting procedure successfully ended. 
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By clicking the “Show Results”  button, which is located at the bottom right 

corner of the current display (see Figure 2.11), the results of the finished fitting 

process are presented (see Figure 2.12).  The fitted parameter values and their 95% 

confidence intervals are shown, together with the columns containing: (1) number of 

data point, (2) x-coordinate, (3) time, (4) concentration, and (5) simulated 

concetration. 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 2.12. “Show results” pane. 
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3.  ColloidFit in depth 
The next sections present an in-depth overview of ColloidFit. Emphasis is given 

to detailed explanation of the three basic features of ColloidFit: (i) Graphing, (ii) 

Fitting, and (iii) Simulating.  

3.1. The Graphing tab 
The “Graphing” tab (see Figure 3.1) is dominated by the graph area {7} that 

contains up to three different kinds of information: (1) Experimental data, (2) Fitted 

curve, and (3) Simulated curve. The orange circles represent the experimental 

concentration data that need to be fitted, the blue curve represents the fitted 

concentration curve, and the red curve represents the simulated concentration curve 

(not shown in Figure 3.1) produced with model parameters defined by the user. 

 

 

 

 

Figure 3.1.  The “Graphing” tab.  

The key elements of the “Graphing” tab (see Figure 3.1) are: 

{1} Graphing tab: The display shown in Figure 3.1 becomes visible when the 

Graphing tab is clicked.  

{2}   Fitting Parameters tab: The fitting configuration tab becomes visible when 

the “Fitting” tab is clicked.  

{3} Simulation tab:  The simulation tab becomes visible when the “Simulation” tab 

is clicked. 
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{4} File menu: Saves the current experiment to the hard disk drive together with 

the produced graphs. 

{5} Options menu: Determines the constants for the simulations and the amount 

of cpus that the user dedicates to the fitting. ColloidFit allows up to eight 

cores to be used in parallel for the fitting process. 

{6} Help menu: Provides helpful information. 

{7} Main graph element. 

{8} Legend of the various data displayed on the graphing element {7}. 

{9} Clear button: Removes selected data from the graphing element {7}. 

{10} History element: By clicking the respective arrows after the completion of the 

fitting process, all of the model simulations that took place during the fitting 

can be viewed one after the other.  Also, for each simulation the associated 

model parameters can be found in elements {11}-{19}  

{11} Hydrodynamic dispersion coefficient, [L2/t] 

{12} Rate coefficient of virus attachment onto the solid matrix, [1/t] 

{13} Rate coefficient of virus detachment from the solid matrix, [1/t] 

{14} Virus inactivation rate coefficient, [1/t] 

{15} Interstitial velocity, [L/t] 

{16} Cross sectional area of the aquifer, [L2]  

{17} Porosity of the solid matrix, [-] 

{18} Virus mass injected into the aquifer, [M] 

{19} Decay rate of viruses attached onto the solid matrix, [1/t]. Please set this 

parameter to zero if the virus inactivation rate coefficient (see element {14}) 

is set to zero.   

{20} The “Continue” button restarts the fitting process with initial parameter 

values the set of values resulted at the end of the previous fitting run. Note 

that, if necessary, the user can easily modify these initial parameter values.  

{21} This window displays messages related to current user actions. Messages 

may indicate system success or failure, depending on the quality of the input 

data provided by the user. 

{22} This window presents the incremental number of the message being 

displayed by element {21}. 

{23} This window displays messages generated by the “Pest” software. These 

messages describe the current status of fitting. 

{24} This window presents the incremental number of the messages being 

displayed by element {23}. 

{25} The “Start Fitting” button initiates the fitting process.  When the “Start Fitting” 

button is clicked, the “Graphing” tab (see element {1}) becomes active. 

{26} This line of text presents crucial messages about the status of ColloidFit. 

{27} When the fitting process is finished successfully, the “Show Results” button 

becomes visible. By clicking the “Show Results” button the fitting results are 

displayed (see Figure 2.12).  

As soon as the fitting button is pressed, the “Graphing” tab becomes active and 

the experimental data are graphically illustrated (see orange circles in Figure 3.1).  

Moreover, on the bottom left corner of the display shown in Figure 3.1, the “Pest” 

software describes the status of the fitting process. Whereas, at the bottom right 

corner of the display shown in Figure 3.1, the “Stop Fitting” button becomes active 

allowing the user to stop the fitting process at any time.   

After the “Pest” software has completed the testing phase, the transport model 

simulations appear in the main graph area of the current display, indicating that the 
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fitting is in progress (see blue curve in Figure 3.1). As time passes, the consecutive 

model simulations improve and match better and better the experimental data. At the 

same time the parameters used to produce the current model simulations are listed 

on the right side of the current display (see Figure 3.1). When the fitting process is 

finished, the “Stop Fitting” button fades away and the “Show Results” button 

becomes visible on the bottom right corner of the current display (see Figure 3.2).  By 

clicking the “Show Results” button, the results of the fitting process (final fitted 

parameter values and corresponding confidence intervals) are displayed. 

Note that a useful functionality of ColloidFit is the ability to continue further the 

fitting process. By pressing the “Continue” button, which is located on the bottom 

right corner of the display presented in Figure 3.1, the fitting process restarts with 

initial parameter values the set of values produced by the last fitting iteration. This is 

a useful function for coping with unsuccessful initial value guesses that yield poor 

results, and thus necessitate the modification of one or more initial values prior to 

starting another fitting run.  

 

3.2. The Fitting tab 
 

When the “Fitting” tab is active, Figure 3.2 is displayed.  

 

Figure 3.2.  Details of the “Fitting” tab. 

The key elements of the “Fitting” tab are: 

{1} Incremental number of data values listed in column {2}. 

{2} Experimental concentration values. 
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{3} This is the column with the “Weights”, which reflect how important (accurate) 

are the corresponding concentration values. Some concentrations may 

incorporate experimental error (uncertainty). The user can reduce the impact 

of uncertain data to the fitting process by simply assigning to these uncertain 

data points a smaller relative weight (importance).  If all weights are set to 

unity, then all concentrations are of equal importance to the fitting process. 

Note that the absolute value of the weights does not really affect the fitting 

process. The fitting results will be the same if all weights are set to “one” or 

“two”.  

{4} Incremental number of the data values listed in columns {5} and {6}. 

{5} Collection times of experimental concentration samples. 

{6} Longitudinal coordinates of sampling points. 

{7} Fixed or initial guess values of the model parameters.  

{8} Indicates whether the corresponding parameter is fixed or will be fitted. It is 

highly recommended that no more than three parameters are fitted 

simultaneously. Of course, ColloidFit can cope with more than three fitting 

parameters; however, the resulting fitted parameter values may not be 

unique (for additional discussion see §5.1). 

{9} Minimum values that the model parameters to be fitted are allowed to take.  

{10} Maximum values that the model parameters to be fitted are allowed to take.  

{11} “Start Fitting” is the button that initiates the fitting process. 

{12} This is a text box for manual insertion of concentration values. 

{13} This is a text box for manual insertion of weight values.  

{14} “Add” is the button that adds the manually inserted values into the text 

boxes {12} and {13} at the end of the “Cexp (t,x)” and “Weight” columns, 

respectively. 

{15} In this window, the user can type notes related to the current fitting project. 

However, the user should avoid using system-reserved symbols like “<<” or 

“>>”. If such symbols are used an error message will appear.  

{16} “Statistical Analysis” is the button that displays extensive statistical 

information and data (for additional discussion see §3.4.4). 

{17} This is a text box for manual insertion of time values.  

{18} This is a text box for manual insertion of x-coordinate values.  

{19} “Add” is the button that adds the manually inserted values into the boxes 

{17} and {18} at the end of the “Time (t)” and “Length (x)” columns, 

respectively. 

 

 The recommended actions that the user must follow for a successful fitting are: 

{1} Insert all experimental concentrations that need to be fitted in the column 

“Cexp”. 

{2} Fill the “Weights” column. Please note that the “Weights” inserted in the 

column reflect how important (accurate) are the corresponding concentration 

values. Some concentrations may incorporate experimental error 

(uncertainty). The user can reduce the impact of uncertain data to the fitting 

process by simply assigning to these data points a smaller relative weight 

(importance).  If all values are of the same importance, then a value equal to 

“1” can be used to the fill the entire column. 

{3} Insert the collection times of the experimental concentrations in the “Time (t)” 

column. 

{4} Insert the x-coordinate of each sampling point. 
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{5} Provide the fixed or initial guess value of each model parameter. 

{6} Specify whether each parameter is fixed or will be fitted. It is highly 

recommended that no more than three parameters should be fitted at a time. 

Of course, ColloidFit can cope with more than three parameters, but the 

resulted parameters may be not unique. 

{7} Finally, press the “Start Fitting” button, located in the right lower corner of the 

current display (see Figure 3.2), to initiate the fitting process. 

 

3.3. The Simulation tab 
 

When the “Simulation” tab is active, Figure 3.3 is displayed.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 3.3.  Details of the “Simulation” tab. 

 

The “Simulation” tab allows the user to perform additional single transport 

simulations at preselected specific points in time and space, independently of any 

fitting process. The user may either fill manually the “Time (t)” (element {2}) and 

“Length (x)” (element {3}) columns by typing in the appropriate values, or generate 

automatically input data over the temporal and the spatial domains. For the second 

case the user may choose a constant x-coordinate value (element {6}) and then 

select an initial temporal value  (element {7}) and a final temporal value (element {8}) 

along with a desired temporal step value (element {9}). Clicking the “Generate input” 

button creates new rows in elements {1}-{4} that hold the generated pairs of time and 

space coordinates. In this case, the space coordinates hold a constant value equal to 

the preselected initial selection, while the time values range from the preselected 
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initial temporal value to the preselected final temporal value, with an incremental step 

equal the preselected temporal step. Similarly, the user may iterate through space 

while holding a constant temporal value, by just using elements {12}-{15}.  It is worthy 

to note here that in both cases, the generated temporal and spatial pairs do not 

substitute any already existing values found in columns {1}-{4}. Instead, they will be 

added at the end of these columns.  Also, note that all simulation results are 

displayed graphically. 

The key elements of the “Simulation” tab displayed in Figure 3.3 are: 

{1} Incremental number of data values listed in columns {2}-{4}. 

{2} Collection times of experimental concentration samples. 

{3} Longitudinal coordinates of sampling points. 

{4} Simulated concentration values. 

{5} This pane automatically generates input data over a user specified temporal 

space. 

{6} The spatial coordinate of sample collection location. 

{7} Starting value for automatic temporal input data generation. 

{8} Ending value for automatic temporal input data generation. 

{9} Time step for automatic temporal input data generation. 

{10} “Generate input” is the button that initiates the automatic generation of input 

data (consisting of temporal and spatial pairs). The columns {2} and {3} are 

filled with the temporal and spatial data, as specified by the elements {6}-{9}. 

Note that the extra rows generated do not overwrite any existing rows, they 

are just are added to the end of the corresponding columns.  

{11} This pane automatically generates input data over a user specified spatial 

space. 

{12} Collection times of experimental concentration samples. 

{13} Starting value for automatic spatial input data generation. 

{14} Ending value for automatic spatial input data generation. 

{15} Spatial step for automatic input data generation. 

{16} “Clear” is the button that clears any data found in elements {12}-{15}. 

{17} “Simulate Data” is the button that starts the transport simulation based on 

the parameter values given, as well as the spatial and temporal data defined 

in elements {2} and {3). Moreover, elements {2} and {3} can be manually 

modified by typing in the time and x-coordinate data. 

{18} “Generate input” is the button that initiates the automatic generation of input 

time and spatial coordinates. The columns {2} and {3} will be filled with the 

temporal and spatial data, respectively, as specified by the elements {12}-

{15}. 

{19} “Graph data” is the button that graphically illustrates the concentrations 

found in column {4}. 

{20} This horizontal bar represents the level of progress towards the complete 

determination of the requested concentrations. 

{21} “Duplicate fitted parameters” is the button that copies the model parameters 

from the “Graphing” tab (see elements {11}-{19} in Figure 3.1) to the 

respective parameter text boxes in Figure 3.3. 

{22} “Statistical analysis” is the button that displays statistical information for the 

concentrations listed in column {4}. 

{23} Text box for manual insertion of time values.  

{24} Text box for manual insertion of x-coordinate values.  

{25} Text box for manual insertion of concentration values. 
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{26} “Add” is the button that adds the manually inserted values into the text 

boxes {23}-{25} to the end of the “Time (t)”, “Length (x)” and “Cexp (t,x)” 

columns, respectively. 

The recommended actions that the user should follow in order to effectively take 

advantage of the “Simulation” tab are the following: 

1) Fill the time and x-coordinate data in the appropriate columns shown in Figure 

3.3. The data can be inserted either manually by simply typing the numerical 

values, or automatically by using the temporal and spatial generators. 

2) Provide the desired model parameter values by either manual typing in the 

appropriate text boxes shown in Figure 3.3, or by copying the existing 

parameter values from the “Graphing” tab shown in Figure 3.1. Note that this 

copying operation can be achieved easily by clicking the “Duplicate fitted 

parameters” button.  

3) Click the “Simulate data” button to start the desired simulation, and then view 

the simulated data in the concentration column. 

4) Note that any “Time (t)”, “Length (x)” and “Cexp (t,x)” column entry can be 

modified if needed. 

5) Click the “Graph data” button to display the generated simulation data in the 

“Graphing” tab with a red curve, as shown in Figure 3.4. 

 

 

Figure 3.4. Display of fitted experimental concentration data together with user 

specified simulated data. 
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3.4. Additional menus 
ColloidFit provides several additional user-friendly menus that allow for fast 

usage and comfortable interaction.  

3.4.1. The “File” menu 

By clicking the “File” menu, an interesting pane is presented, as shown in Figure 3.5. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 3.5.  The “File” menu. 

 

The key elements of the “File” menu, shown in Figure 3.5, are: 

(1) The item “New Project” creates a new ColloidFit project and clears all 

previously occupied text fields. 

(2) The item “Open Project” allows the user to search the hard drive and open an 

existing ColloidFit project.   

(3) The item “Save Project” saves the current ColloidFit project to the hard disk 

with the previously saved project name, or initiates a save dialog in order to 

choose a new project name and specify the folder that will be saved. 

(4) The item “Save Project as …” displays a window with instructions on how to 

save the current project for the first time. 

(5) The item “Recent” shows any recently opened or closed ColloidFit projects. 

(6) The item “Exit” shuts down all processes and closes the ColloidFit program.   
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3.4.2. The Options menu 

 

Clicking on “Edit” -> “Options”, the options menu is displayed. 

 

 

 

 

 

 

 

 

 

  

                      (a)                                                                           (b) 

 

 

 

 

 

 

 

 

 

 

 

                   (c)                                                                                (d) 

Figure 3.6.  The “Options” menu: “Simulation Models” tab. 

The “System Options” menu, as shown in Figure 3.6a, contains various system 

configurations and options that allow the user to optimize the fitting process as 

needed. The most important item of the menu is the “Simulation Model”, found under 

the “General” tab (see Figures 3.6a,b,c,d). The user is free to select any simulation 

model at any time. The only restriction is that no fitting should be active at the 

moment of selection. Upon the selection of the model, several necessary changes 

occur in the various user interface tabs (see Figures 3.1-3.3), so that the new model 

parameters may be properly accommodated. ColloidFit can handle the transport of 
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two different types of suspended particles: (i) Colloids, indicated as “Transport C.”  

(see Figure 3.6b), and (ii) Viruses, indicated as “Transport V.”  (see Figure 3.6c). 

Also, ColloidFit can handle batch particle attachment experimental data by the use of 

various frequently employed equilibrium and kinetic particle attachment models (see 

Figure 3.6d). Furthermore, if any of the selected transport models accounts for 

gravity then the “Gravity effects” button become visible (see Figure7a,b). When the 

“Gravity effects” button is clicked the “Set gravity parameters” menu appears (see 

Figure 3.14).    

 

 

 

 

 

 

 

 

 

 

 

                      (a)                                                                             (b) 

Figure 3.7.  The “Options” menu: “Simulation Models” tab showing the available 

particle transport options with gravity effects. 

Within the “General” tab (see Figure 3.6a) the user can find options of how to 

change the units displayed in graph (see Figure 3.5). Several combinations are 

available for the nominator and denominator part of y-axis (see Figure 3.9a,b). Also, 

the x-axis may have units of either time or x-coordinate length (see Figure 3.9c,d).    

All necessary information related to the accuracy of the numerical procedures 

employed by ColloidFit can be found in Figure 3.8b. For additional numerical 

accuracy details see the section §4.10. 

The available “Simulations Accuracy” options, as shown in Figure 3.8b, are: 

(1) The “Relative simulation accuracy” value represents the relative error 

allowed between successive iterations of the integration solver. 

(2)   The “Absolute simulation accuracy” value represents the maximum absolute 

error allowed between successive iterations of the integration solver. If this 

value is set to zero, then only the relative accuracy is considered. 

(3)   The "Maximum number of subdivisions for integrals” value sets the 

maximum number of allowed subdivisions in a single integration step.   

Finally, the “Formatting Numbers” tab (see Figure 3.8c), which contains the 

following formatting notation options for the numerical values: “Original”, “Decimal”, 

“Exponential” and “Auto”. The “Original” format keeps the numerical values exactly as 
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they were inserted originally in ColloidFit. The “Decimal” format displays the 

numerical values in decimal notation, and the “Exponential” format displays the 

numerical values in E notation. For both “Decimal” and “Exponential” formats, the 

number of decimal places can be customized. The “Auto” format displays the 

numbers in a mixed style by combining both the “Exponential” and “Decimal” format 

in order to create a visually appealing result. It is worthy to mention here that all 

formatting notation options keep the inserted numerical values to their original level 

of accuracy, and only the style of representation is changed. 

 

 

 

 

 

 

 

 

 

 

 

 

                   (a)                                                                                 (b) 

 

 

 

 

 

 

 

 

 

 

 

                                                                  (c) 

Figure 3.8.  The “Options” menu: “Axis Labels”, “Simulation Accuracy” and 

“Formatting Number” tabs.  
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                      (a)                                                                           (b) 

 

 

 

 

 

 

 

 

 

 

 

(c)                                                                                (d) 

Figure 3.9.  The “Options” menu showing all the available units for the x-axis and              

y-axis.  

In order to use most of the processing resources of the latest PC systems, 

there are build in options available (see Figure 3.10a) that allow for parallel execution 

of fitting. This is an important and effective way to cut down the total time of 

execution. For parallel simulation to work properly, the system needs to have multi 

CPU processors without any load, at least at the beginning of the fitting process, and 

the time for each model execution exceeds 20 seconds. Otherwise, the 
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parallelization is not effective, and the total time for the fitting process is increased 

due to the extra time needed for the parallel reading and writing of internal system 

files that coordinate the fitting process. The current version of ColloidFit++ V1.1 beta 

allows up to 8 different parallel processes, a feature which most of the times is not 

needed. The user should gradually increase the parallel processes from two to three 

and so on, while keeping in check the total fitting time. As long as the total time is 

decreasing, then the number of parallel processes can be increased.  

ColloidFit was introduced, in section §2.1, with the help of a simple step-by-

step “Guide”. The advanced user may avoid the step-by-step “Guide” by disabling it 

from the “Display guide” option, which can be found in the “Advanced” options menu 

(see Figure 3.10b). Certainly, if needed, the step-by-step “Guide” can be re-enabled.  

 

 

 

 

 

 

 

 

 

 

 

 

                     (a)                                                                            (b) 

Figure 3.10.  The “Options” menu: “Number of CPUs” and “Guide”. 

 

Furthermore, both “Fitted” and “Simulated” curves shown in the “Graphing” tab 

(see Figure 3.4) can be constructed either by connecting the data points with simple 

lines or by the use of Bezier cubic splines. The second option (see Figure 3.11) 

yields smoother curves. Unfortunately, Bezier cubic splines are bound to overshoot 

and create artificial oscillations in some cases when the slope between sequential 

points is great. For most cases it is recommended to use the default “Bezier cubic 

spline” option. An overshooting example is illustrated in Figure 3.12.  
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Figure 3.11.  The “Options” menu:  “Plotting Options” tab. 

 

 

 

 

 

 

 

 

 

                         (a)                                                                       (b) 

Figure 3.12. Curve construction by: (a) Bezier cubic splines (illustrating a case of 

overshooting), (b) linear approach.   

The last option of the “System Options” menu is the “Speed Constraints” 

feature (see Figure 3.13). This option allows the user to change the predefined delay 

time that is automatically inserted between successive reads and writes of important 

fitting system files. The original value of 50% can be used for most of the existing 

PCs. For strong computer systems, this value can be reduced to 25% or less. The 

result will be faster fitting times. This is effective only when single simulations are 

extremely fast and need approximately 0.1 seconds to complete. This is the case for 

most of the adsorption models employed by ColloidFit. If execution time for a single 

simulation is not small enough (more than 10 seconds), then no acceleration in the 

total fitting time will be noticed. The “Delay time” should be decreased only with 

extreme caution. For older computer systems it could lead to system instability with 

unexpected behavior. 
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   Figure 3.13.  The “Options” menu: “Speed Constraints” tab. 

 

3.4.3. The Gravitational forces menu 

ColloidFit allows certain models to account for gravity effects. The 

corresponding menu appears (see Figure 3.14) when the “Gravity effects” button is 

pressed (see Figure 3.7a,b). The user can fill all the blank text boxes with the 

required parameters. Subsequently, by clicking the “Calculate effective U” button, the 

corresponding interstitial velocity that accounts for gravity effects is determined. This 

value can be copied directly into the “Fitting” tab (see Figure 3.2) and then initiate a 

fitting process that accounts for gravity effects. 

There are a two additional options displayed in Figure 3.14 that provide more 

flexibility for the determination of the effective velocity: (1) The parameter fs [-] can be 

set equal to 0.9 (fs0.9) if the grains of the porous medium do not provide additional 

frictional resistance, but only contribute to the tortuosity (Wan and Tsang, 1995). 

Otherwise, fs [-] can be evaluated from equation (4.4) with the appropriate values for 

b [-] and ε [-]. (2) The interstitial water velocity can be either determined with the 

following equation U=Q/(A), or can be inserted directly in the proper window, 

assuming that it’s value is known. 

Furthermore, in the “Determination of Gravitational Effects” display (see Figure 

3.14), a table is provided with water dynamic viscosity and density values for various 

temperatures (http://www.thermexcel.com/english/tables/eau_atm.htm). This table is 

useful when the ρw and μw parameter values are needed. The user must fill in all 

parameters values with the specified units, otherwise mathematical errors will occur. 
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                          Figure 3.14.  The “Set gravity parameters” menu.  

3.4.4. The Statistical menu 

When the “statistical analysis” button (introduced in sections §3.2-3.3) is 

clicked, the corresponding “Statistical Information” menu appears, as shown in Figure 

3.13. This menu contains on the left side the statistical properties, and on the right 

side the parameter values used. The statistical information can be displayed even 

while the fitting process is in progress. If for an unfortunate reason one or more of the 

parameter values used are incorrect, the user can easily edit the parameter values 

and then by clicking the “refresh” button, all statistical values are recalculated with 

the freshly edited parameter values. Furthermore, the temporal moments are 

calculated based on the theoretical developments presented by Chrysikopoulos and 

Syngouna (2014), which are also described in section §4.8. Note that the statistical 

analysis option is available only for the transport models (see Table 4.1). Attachment 

models don’t support this feature.   

 

 

 

 

 

 

 

 

 

 

Figure 3.15 The “Statistical Information” menu. 
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4. Mathematical modeling for particle transport  
 

ColloidFit employs two different categories of models for: (i) particle transport in 

porous media, and (ii) particle attachment onto the solid matrix (batch systems). The 

transport models are applicable to two different types of particles (colloids and 

viruses) under two different source loadings (instantaneous and broad pulse). The 

colloid particles may be either suspended in the aqueous phase or attached 

reversibly and/or irreversibly onto the solid matrix. The virus particles may be either 

suspended in the aqueous phase or attached reversibly onto the solid matrix. Viruses 

suspended in the aqueous phase and attached onto the solid matrix are assumed to 

undergo inactivation with different rates. The transport of particles undergoing strictly 

reversible attachment is described by the models developed by Sim and 

Chrysikopoulos (1995), and Thomas and Chrysikopoulos (2007). Furthermore, the 

transport of particles undergoing a combination of reversible as well as irreversible 

attachment (mixed) is handled by the methods developed by Katzourakis and 

Chrysikopoulos (2014). All of the transport models employed by ColloidFit can be 

modified to handle dense particles by accounting for gravity forces as described by 

Chrysikopoulos and Syngouna (2014) and Katzourakis and Chrysikopoulos (2015). 

The various transport models employed by ColloidFit are listed in Table 4.1. 

 

Table 4.1 Available ColloidFit transport models 

No Particle type Source type Gravity effects* Attachment** 
1 Virus Instantaneous w/o gravity Reversible 
2 Virus Broad pulse w/o gravity Reversible 
3 Virus Instantaneous w/ gravity Reversible 
4 Virus Broad pulse w/ gravity Reversible 
5 Colloid Instantaneous w/o gravity Reversible 
6 Colloid Broad pulse w/o gravity Reversible 
7 Colloid Instantaneous w/ gravity Reversible 
8 Colloid Broad pulse w/ gravity Reversible 
9 Colloid Instantaneous w/o gravity Mixed 
10 Colloid Broad pulse w/o gravity Mixed 
11 Colloid Instantaneous w/ gravity Mixed 
12 Colloid Broad pulse w/ gravity Mixed 

 

*  “w/o” indicates without and “w/” with. 

** Mixed attachment refers to the combined reversible and/or irreversible attachment. 
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4.1 Virus transport modeling 
The transport of suspended virus particles in one-dimensional, saturated, 

homogeneous porous media with uniform flow, accounting for nonequilibrium 

reversible attachment onto the solid matrix, inactivation with different rates, and 

gravity effects, is governed by the following partial differential equation (Sim and 

Chrysikopoulos, 1995): 

            (4.1) 

where  [Mv/L3] is the concentration of virus; 
vD  [L2/t] is the longitudinal 

hydrodynamic dispersion coefficients of the suspended virus particles;  [1/t] is the 

decay rate of the viruses suspended in aqueous phase; and  [1/t] is the decay rate 

of the viruses attached onto the solid matrix. U [L/t] is the average interstitial velocity 

along the x-direction; and  [L/t] is the x-directional component of the “restricted 

particle” settling velocity, which is just a modification of the “free particle” settling 

velocity, commonly used in static water columns (Russel et al., 1989), applicable to 

granular porous media (Chrysikopoulos and Syngouna, 2014):                                   

                                                                                         (4.2)                       

where fs [–] is the correction factor accounting for particle settling in the presence of 

the solid matrix of granular porous media; w [M/L3] is the density of the suspending 

fluid (water); p [M/L3] is the density of the colloid particle; μw [M/(L·t)] is the dynamic 

viscosity of water; dp [L] is the colloid particle diameter; and   [L/t2] is the x-

directional component of the gravity vector defined as: 

 

                                                                                                        (4.3)                                                    

where g [L/t2] is the acceleration due to gravity;  [] is the angle of the main flow 

direction (x-direction) with respect to the direction of gravity (0β180); i is the unit 

vector parallel (x-direction) to the flow, respectively (see Figure 4.1). The correction 

factor, fs, is expressed as follows (Wan and Tsang, 1995): 

                                                                                               (4.4)                        

where b1 is the average free settling segment length to the grain radius ratio, and   

 [–] (01) is an empirical correction factor that takes into account the effect of the 

grain surface. Note that fs0.9 when the grains of the granular porous media do not 

provide additional frictional resistance, but only contribute to the tortuosity (Wan and 

Tsang, 1995).  
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The second accumulation term on the left hand side of equation (4.1) is given by 

(Sim and Chrysikopoulos, 1995): 

                       (4.5) 

where  [1/t] is the rate coefficient of virus attachment onto the solid matrix; and 

 [1/t] is the rate coefficient of virus detachment from the solid matrix. 

 

 

Figure 4.1. Schematic illustration of the gravity vector components for: (a) 

horizontal flow, (b) up-flow, and (c) down-flow conditions. The angle β (0β180) is 

between the main flow direction (x-direction) and the direction of gravity (Katzourakis 

and Chrysikopoulos, 2014). 
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4.2 Virus source loading  
The initial condition and the appropriate boundary conditions for a one-

dimensional semi-infinite aquifer are as follows (Sim and Chrysikopoulos, 1995; 

Thomas and Chrysikopoulos, 2007): 

                                                     
                                             (4.6)

 

                                                    
                                            (4.7)

 

          

 

             (4.8)

 

                             (4.9)
                                             

 

where =Min/Ac [Mv/L2] is the mass injected “instantaneously” over the cross-

sectional area of the column (where Min [Mv] is the colloid injected mass, Ac [L2] is the 

cross sectional area of the porous medium);  [Mv/L3] is the injected constant 

concentration of virus;  vD  [L2/t] is hydrodynamic dispersion of the virus; U [L/T] is the 

interstitial velocity; Min [M] is the injected mass, and δ(t) is the modified Dirac delta 

function. Condition (4.6) establishes that there is no initial concentration of virus 

within the porous medium. While downstream condition (4.7) preserves concentration 

continuity (Sim and Chrysikopoulos, 1995). Upstream equations (4.8) and (4.9) 

define the way the viruses are introduced into the aquifer. Condition (4.8) refers to a 

continuous source that provides constant concentration of virus over a predefined 

time period tp (Sim and Chrysikopoulos, 1995).  Whereas, equation (4.9) refers to an 

instant injection of the virus with total injected mass equal to Min. 

  

 

4.2.1 Analytical solution for instantaneous source  
The analytical solution to the model for virus transport in porous media 

described in §4.1 (see Table 4.2) with instantaneous source has been derived by 

Thomas and Chrysikopoulos (2007):  

  (4.10) 
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where J1 is the Bessel function of the first kind of order one; “exp” is the exponential 

function; “erfc” is the complementary error function,  is a dummy integration 

variable; ; ; and . In order to evaluate the above 

analytical solution for B<0, the following relationship is employed (Abramowitz and 

Stegun, 1964): 

                                                    (4.11) 

where I1 is the modified Bessel function of the first kind of order one. Therefore, the 

term  is replaced by . 

Furthermore, in order to account for gravity effects, the velocity term in the analytical 

solution (4.10) was replaced with Utot, which is the sum of the average interstitial 

velocity U and the settling vector component , as follows:  

                                                                                                                               (4.12) 
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4.2.2 Analytical solution for broad pulse source 
The analytical solution to the model for virus transport in porous media 

described in §4.1 (see Table 4.2) with a broad pulse injection source is obtained by a 

slight modification of the analytical solution presented by Sim and Chrysikopoulos 

(1995) as follows:  

                                           (4.13) 

 
where  

           (4.14) 

where J0 is the Bessel function of the first kind of zeroth order, “exp” is the 

exponential function; “erfc” is the complementary error function;  and  are dummy 

integration variables; ; ; and . In the analytical 

solution (4.14), to account for gravity effects, the velocity term was replaced with Utot, 

which is defined by equation (4.12).  
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4.3 Colloid transport in porous media with reversible attachment 
The transport of suspended colloid particles in one-dimensional, saturated, 

homogeneous porous media with uniform flow, accounting for nonequilibrium 

reversible attachment onto the solid matrix along with gravity effects, is governed by 

the following partial differential equation (Sim and Chrysikopoulos, 1995; 

Chrysikopoulos and Syngouna, 2014; Katzourakis and Chrysikopoulos, 2014):             

       (4.15) 

where  [Mc/L3] is the concentration of colloids;  t [t] is time; x [L] is the Cartesian 

coordinate in the longitudinal direction; b[Ms/L3] is the bulk density of the solid 

matrix;  [–] is the porosity of the porous medium; cD  [L2/t]  is the longitudinal 

hydrodynamic dispersion coefficient of the suspended colloids; and U [L/t] is the 

average interstitial velocity along the x-direction.  

Given that the colloids attached onto the solid matrix, , are assumed to be 

reversibly attached,  [Mc/Ms], then  and the accumulation term in 

equation (4.15) can be expressed by (Sim and Chrysikopoulos, 1995): 

                                       (4.16) 

where   [1/t] is the forward rate coefficient of colloid attachment onto the solid 

matrix, and  [1/t] is the reverse rate coefficient of colloid detachment from the 

solid matrix.  

 

4.4 Colloids source loading  
The initial condition and the appropriate boundary conditions for a one-

dimensional semi-infinite aquifer are as follows (Sim and Chrysikopoulos, 1995; 

Thomas and Chrysikopoulos, 2007):  

                                                  
                                                (4.17)

 

                                                  
                                               (4.18)

 

                 

 

      (4.19)

 

                                            (4.20)
                                             

 

where =Min/Ac [Mc/L2] is the mass injected “instantaneously” over the cross-

sectional area of the column (where Min [Mc] is the colloid injected mass, Ac [L2] is the 

cross sectional area of the porous medium);  [Mc/L3] is the injected constant 

concentration of colloids;  Dc [L2/t] is hydrodynamic dispersion of the colloids; U [L/t] 
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is the interstitial velocity; Min [M] is the injected mass, and δ(t) is the modified Dirac 

delta function. Condition (4.17) establishes that there is no initial concentration of 

colloids within the porous medium. While downstream condition (4.18) preserves 

concentration continuity (Sim and Chrysikopoulos, 1995). Upstream equations (4.19) 

and (4.20) define the way the colloids are introduced into the aquifer. Condition 

(4.19) refers to a continuous source that provides constant concentration of the 

colloids over a predefined time period tp (Sim and Chrysikopoulos, 1995). Whereas, 

equation (4.20) refers to an instant injection of the colloids with total injected mass 

equal to Min.  

 

 

4.4.1 Analytical solution for instantaneous source  
The analytical solution for the colloid transport model for instantaneous source 

with reversible attachment, described in §4.4 (see Table 4.2), is given by (Thomas 

and Chrysikopoulos, 2007):   

     (4.21) 

where J1 is the Bessel function of the first kind of order one; “exp” is the exponential 

function; “erfc” is the complementary error function,  is a dummy integration 

variable; ; ; and . In order to evaluate the above 

analytical solution for B<0, the following relationship is employed (Abramowitz and 

Stegun, 1964): 

                                                   (4.22) 

where I1 is the modified Bessel function of the first kind of order one. Therefore, the 

term  is replaced by .  

Furthermore, in in order to account for gravity effects, the velocity term in the 

analytical solution (4.21) was replaced with Utot, which is defined by equation (4.12). 
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4.4.2 Analytical solution for broad pulse source 
The analytical solution for the colloid transport model with broad pulse injection 

source and reversible attachment, described in §4.4 (see Table 4.2) can be obtained 

by slight modification of the solution reported by Sim and Chrysikopoulos (1995) as 

follows:    

                                                        (4.23) 

 
 
 
where  

           (4.24)  

 

where J0 is the Bessel function of the first kind of zeroth order, “exp” is the 

exponential function; “erfc” is the complementary error function;  and  are dummy 

integration variables; ; ; and .  In the analytical solution 

(4.24), to account for gravity effects, the velocity term was replaced with Utot, which is 

defined by equation (4.12).  

 

 

 



41 
 

ColloidFit: User Manual v.1.3.1 (November 2019) 

4.5 Colloid transport in porous media with combined reversible 

and irreversible (mixed) attachment 
 

For colloids undergoing reversible as well as irreversible (mixed) attachment, 

the total attached colloids concentration,  [Mc/Ms], in the governing colloid 

transport partial differential equation (4.1) is represented as (Katzourakis and 

Chrysikopoulos, 2014):  

                                                                                              (4.25) 

where  [Mc/Ms] is the colloid concentration irreversibly attached onto the solid 

matrix;  [Mc/Ms] is the colloid concentration reversibly attached onto the solid 

matrix. Consequently, the colloid accumulation term in equation (4.15) is expressed 

as (Compere et al., 2001; Katzourakis and Chrysikopoulos, 2014): 

                                             (4.26) 

where the reversible accumulation terms is given by (Sim and Chrysikopoulos, 1995): 

                 (4.27) 

and the irreversible accumulation term is given by:  

                                                                      (4.28) 

where  [1/t] is the forward rate coefficient of irreversible colloid attachment onto 

the solid matrix. Substituting equations (4.26) and (4.28) in the colloid transport 

equation (4.15) yields the following relationship: 

 

                                        (4.29) 

 

which is the governing colloid transport equation in porous media with combined 

reversible and irreversible attachment. Note that the reversible term found on the left 

hand side of (4.29) is described by equation (4.27). 

 

 

 

4.5.1 Analytical solution for instantaneous source 
  The analytical solution to the model for colloid transport in porous media with 

combined reversible and irreversible (mixed) attachment described in §4.5 (see 

Table 4.2), for an instantaneous source can be obtained by direct comparison of the 

governing virus transport equation (4.1) and colloid transport equation (4.29). Clearly, 

it is evident that the forward irreversible attachment rate ( ) corresponds to the 

inactivation or decay rate of the viruses suspended in aqueous phase ( ), while the 

decay rate of the viruses attached onto the solid matrix ( ) is equal to zero for the 

case of colloids. Therefore, the analytical solution to the model for colloid transport 
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with mixed attachment and instantaneous source is essentially the virus analytical 

solution (4.10) with  replaced by  and  set to zero. Naturally,  and  

correspond to (r)c-c*
r  and (r)c* -c

r , respectively.  The resulting analytical solution is:  

   (4.30) 

where J1 is the Bessel function of the first kind of order one; “exp” is the exponential 

function; “erfc” is the complementary error function,  is a dummy integration 

variable; ; ; and . In order to evaluate the above 

analytical solution for B<0, the following relationship is employed (Abramowitz and 

Stegun, 1964): 

                                                   (4.31) 

where I1 is the modified Bessel function of the first kind of order one. Therefore, the 

term  is replaced by . 

Furthermore, in the analytical solution (4.30), to account for gravity effects, the 

velocity term was replaced with Utot, which is defined by equation (4.12). 
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4.5.2 Analytical solution for broad pulse source 
The analytical solution to the model for colloid transport in porous media with 

combined reversible and irreversible (mixed) attachment described in §4.5 (see 

Table 4.2), for a broad pulse source can be obtained by direct comparison of the 

governing virus transport equation (4.1) and colloid transport equation (4.29). Clearly, 

it is evident that the forward irreversible attachment rate ( ) corresponds to the 

inactivation or decay rate of the viruses suspended in aqueous phase ( ), while the 

decay rate of the viruses attached onto the solid matrix ( ) is equal to zero for the 

case of colloids. Therefore, the analytical solution to the model for colloid transport 

with mixed attachment and broad pulse source is essentially the virus analytical 

solution (4.13) and (4.14) with  replaced by  and  set to zero. Naturally, 

 and  correspond to 
 
r
c-c*(r)  and 

 
r
c*(r) -c

, respectively.  The resulting analytical 

solution is:  

                                                              (4.32) 

where  

           (4.33) 
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where J0 is the Bessel function of the first kind of zeroth order, “exp” is the 

exponential function; “erfc” is the complementary error function;  and  are dummy 

integration variables; ; ; and . In the analytical 

solution (4.33), to account for gravity effects, the velocity term was replaced with Utot, 

which is defined by equation (4.12).   

 

4.6 List of the transport models employed in ColloidFit 
 

 The particle (colloid and virus) transport models described in sections §4.1-4.5   

are summarized as follows in Table 4.2. 

 

Table 4.2 Available ColloidFit transport models 

No Particle type - Source type Attachment* Equations 

1 Virus Instantaneous Reversible (4.1), (4.5)-(4.7), (4.9) 

2 Virus Broad pulse Reversible (4.1), (4.5)-(4.8) 

3 Virus Instantaneous with gravity Reversible (4.1)-(4.7), (4.9) 

4 Virus Broad pulse with gravity Reversible (4.1)-(4.8) 

5 Colloid Instantaneous  Reversible (4.15)-(4.18), (4.20) 

6 Colloid Broad pulse Reversible (4.15)-(4.19) 

7 Colloid Instantaneous with gravity Reversible (4.2)-(4.4), (4.15)-(4.18), (4.20) 

8 Colloid Broad pulse with gravity Reversible (4.2)-(4.4), (4.15)-(4.19) 

9 Colloid Instantaneous  Mixed (4.15), (4.17), (4.18), (4.20), (4.25)-(4.28) 

10 Colloid Broad pulse Mixed (4.15), (4.17)-(4.19), (4.25)-(4.28) 

11 Colloid Instantaneous with gravity Mixed (4.2)-(4.4), (4.15),(4.17),(4.18),(4.20),(4.25)-(4.28) 

12 Colloid Broad pulse with gravity Mixed (4.2)-(4.4), (4.15),(4.17)-(4.19),(4.25)-(4.28) 

*Mixed attachment refers to the combined reversible and/or irreversible attachment. 
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4.7 Attachment equations  
In section §3.4.2 and more specifically in Figure 3.6d the user had the chance 

to view a number of the available attachment equations. All the attachment model 

equations used by ColloidFit are listed in Tables 4.3 and 4.4: 

Table 4.3 Available ColloidFit non-equilibrium adsorption models 

Num Model Mathematical Description Equation # 

1 Linear reversible  (4.34) 

2 
Non linear 

reversible 
 (4.35) 

3 Kinetic product  (4.36) 

4 Bilinear  (4.37) 

5 Mass transfer  (4.38) 

6 Elovich model  (4.39) 

7 
Pseudo second-

order 
 (4.40) 

 

 

Table 4.4 Available ColloidFit equilibrium attachment models 

Num Model Mathematical Description Equation # 

1 Linear  (4.41) 

2 Freundlich  (4.42) 

3 Langmuir  (4.43) 

 

Note that for all adsorption/attachment models (4.34)–(4.43) it is assumed that 

initially the attached concentration  [Mc/Ms] is zero:  

                                                                                                          (4.44) 
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4.8 Decay/inactivation models  
 

The decay/inactivation model equations used by ColloidFit are listed in Tables 

4.5: 

Table 4.5 Available ColloidFit decay/inactivation models 

Num Model Mathematical Description Equation # 
1 Two-parameters  (4.45) 

2 Three-parameters  (4.46) 

 

where in equations (4.45)-(4.46) 0C  [Mv/L3]  is the initial virus concentration. 

 

4.8 Temporal moments  
 

 The particle (virus or colloid) concentrations collected at the column exit can 

be analyzed by the absolute temporal moments: 

                                                                                     (4.47) 

where the subscript n=0, 1, 2, ... indicates the order of the moment, and L [L] is the 

porous medium (column) length. The zeroth absolute temporal moment, m0 [tM/L3], 

quantifies the total mass in the concentration distribution curve; the first absolute 

moment, m1 [t2M/L3], describes the mean residence time; and the second absolute 

temporal moment, m2 [t3M/L3], describes the degree of spreading of the concentration 

distribution curve. Also, the normalized temporal moments are defined as (James 

and Chrysikopoulos, 2011): 

                                                                        (4.48) 

The first normalized temporal moment, M1 [t], characterizes the center of mass of the 

concentration distribution curve and defines the average velocity. The second 

normalized temporal moment, M2 [t2], characterizes the spreading of the 

concentration distribution curve. Worthy of note is that the mass recovery, Mr [–], of 

the suspended particles is quantified for the instantaneous loading by the following 

expression (Chrysikopoulos and Katzourakis, 2014): 

                                                                                                      (4.49) 

where  [M/L2] is the mass injected “instantaneously” over the cross-

sectional area of the column (where Min [M] is the injected mass; A [L2] is the cross 
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sectional area of the porous medium); Utot [L/T] is the total velocity given from 

equation (4.12). Furthermore, for broad-pulse source loading the mass recovered is 

given from (Chrysikopoulos and Syngouna, 2014):   

                                         (4.50) 

Where C0 [M/L3] is the constant injected concentration of suspended particles, over a 

predefined time period tp. 

 

 

4.9 Simplified parameter notation 
In order to simplify the ColloidFit user interface parameter notation, the 

symbols described and used in sections §4.1-4.6 were changed as shown in Table 

4.5. The “Equations Symbols” column refers to the symbols used in equations found 

in section §4. The “Colloid Symbols” column refers to the symbols plotted in 

ColloidFit user interface when the colloid simulation model is selected. The “Virus 

Symbols” column refers to the symbols plotted in ColloidFit user interface when the 

virus simulation model is selected (see Figures 3.1 and 3.7).  

 

Table 4.5 Available ColloidFit equilibrium adsorption models 

Equation 
Symbols 

Colloid  
Symbols 

Virus 
Symbols 

Dx Dx Dx 
 r1 - 

 r2 - 
 kirr - 
 - r1 
 - r2 

 - λ 

 - λ* 

Utot  Ueff Ueff 
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4.10 Numerical procedures  
The transport model equations where solved analytically by using already 

existing 1-D solutions found in literature   (Sim and Chrysikopoulos, 1995; Thomas 

and Chrysikopoulos, 2007). The resulting integral were approximated numerically 

using open source libraries Quadpack QAGS intergrator. QAGS is a simple globally 

adaptive integrator using the strategy of Aind (Piessens, 1973).  It is possible to 

choose between 6 pairs of Gauss-Kronrod quadrature formula for the rule evaluation 

component. The pairs of high degree of precision are suitable for handling integration 

difficulties due to a strongly oscillating integrand. All mathematical handling was 

implemented in Fortran using the highest possible accuracy settings 

Adsorption equations were solved again with the open source software 

ODEPACK (Hindmarsh et al., 1983; Petzold et al., 1983) using DLSODA subroutines 

that implement an automatic stiff or not stiff differential equation solver. 
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5. Fitting process 
 

5.1 Introduction to fitting 
The fitting process should not be considered as an easy task to perform. 

Certainly, starting with any set of preselected initial parameter values may not always 

yield the absolute best-fitted parameter values. Therefore, it is important to carefully 

select initial parameter values as close as possible to the best-fitted values. Also, by 

providing, in the “Fitting” tab, the lower and upper limits for each parameter to be 

fitted, ColloidFit is restricted from giving best-fitted parameter values with no physical 

meaning. 

Another important parameter when performing a fitting is the number of 

parameters to be fitted. An absolute number of three parameters fitted at a time (for 

the transport models) is a rule of thumb that protects the fitted results from having no 

physical meaning. ColloidFit allows a max number of four parameters to be fitted at a 

time but that’s to be on the safe side. Even if someone tried to fit four or more 

parameters the local minimums and maximum are so many that prevent any fitting 

progress. To that end there is special case for the virus transport problems, where 

the λ* parameter is tied to the λ parameter. Consequently, the ratio λ/λ* is kept 

constant and only the coefficient λ is fitted.  

 

5.2 Theory of fitting 
ColloidFit utilizes the state of the art fitting software package Pest (Doherty, 

2005). Pest provides the smallest possible sum of squared deviations between 

experimental and model-generated data. This sum is known as the “objective 

function” and the smaller is this value the greater is the consistency between 

experimental and model observations and the greater is our confidence that the 

parameters determined are correct. From a mathematical point of view, we want to 

minimize , where  is given by the following equation:  

                                                
(5.1) 

where  c now holds the set of experimental data; the  is a matrix containing the 

response of any physical system to any outside excitation; the  superscript “t” 

indicates the matrix transpose operation. Note that the vector b,  that minimizes  

in equation (5.1), is given by:  

                                                             (5.2) 

which provides a unique solution to the parameter estimation problem, as long as 

that the number of observations m equals or exceeds the number of parameters n. 

Assuming that the matrix ( ) is positive definite under these conditions, the 

solution can easily be obtained numerically.  

Despite the fact that equation (5.2) is enough to perform the parameter estimation, 

equation (5.2) is not applicable to all kind of problems because it inherently assumes 

that all observations are of equal importance and have the same uncertainty.   

The aforementioned problem can be resolved if a weight is supplied with each 

observation. The larger the weight associated with a particular observation the 

greater the impact that the observation has in the objective function. If the 

observation weights are housed in a square, m-dimensional, diagonal matrix Q 
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whose ith diagonal element is the square of the weight wi attached to the ith 

observation, then equation (5.2) can be written as:  

                                            
(5.3) 

or, equivalently as,  

                                                                   
                                              

(5.4) 

where ri (the ith residual) is the difference between the actual field or laboratory 

measurement and the model outcome for the ith observation. If observation weights 

are properly assigned (i.e. if they are assigned such that each weight is inversely 

proportional to the standard deviation of the observation with which it is associated), 

then equation (5.3) can be written as follows:  

                                                                                    
(5.5) 

where  

                                                      (5.6) 

And σ2 (variance of each of the elements of c) is obtained from:  

                                                                                                   (5.7) 

where n is the dimension of  vector b; m-n is the dimension of  vector c; C(c) 

represents the covariance matrix of the m-dimensional observation random vector c 

of which our measurement vector is a particular realization. Given that Q is a 

diagonal matrix, so is P, its elements being the reciprocals of the corresponding 

elements of Q. The assumption of independence of the observations is maintained 

through insisting that Q (and hence P) have diagonal elements only. Where the 

elements of Q are the squares of the observation weights. It is worthy to note here 

that the weights as defined in equations (5.3) and (5.4) are actually the square roots 

of the weights defined by some other investigators. This alternative style was 

adopted because  users find it easier to think in terms of standard deviations than 

variances, when assigning weights to observations.  

Finally, with the inclusion of observation weights equation (5.2), by which the system 

parameter vector is estimated, can be written as.  

                                                                                        (5.8) 

For additional information about the fitting procedures employed by the Pest software 

(Doherty, 2005), the users are encouraged to consult: “The new PEST manual part I” 

& “The new PEST manual part II”, which can be found at the download section of 

Pest homepage http://www.pesthomepage.org/Downloads.php.  

 

http://www.pesthomepage.org/getfiles.php?file=newpestman1.pdf
The%20new%20PEST%20manual%20part%20II
http://www.pesthomepage.org/Downloads.php
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6. Troubleshooting 
 

There are cases for which even if the user presses the start fitting button nothing 

happens, despite having properly inputted all the parameters required. This is 

because some antiviruses like Avira treat FORTRAN executable as false positive 

viruses, and as such they guarantee them. Please note the official release of 

ColloidFit, downloaded from http://tuceel.tuc.gr/downloads, is absolutely clean of 

viruses. Download only from official servers. 

 

7. Known issues 
 

Current version 1.3 beta: 

1. Depending on operating system’s default font there is a chance some 

explanatory texts, contained in textboxes in the system options menu, not to 

be displayed properly (seen as a whole). 

2. In some cases, the ColloidFit log file that holds the Pest output, may resist the 

delete commands, which are issued after the initiation of a fitting cycle. 

Consequently, previous useless output information may be displayed every 

time a fitting process is initiated. This problematic issue yields long Pest 

output that exceeds 1000 lines. This issue can be fixed only by a complete 

Operating System restart. 

3. The ColloidFit project icon in the Mac version may not always be displayed 

properly. 
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8. Changelog  
 

Changes of version 1.3.1 from version 1.2.1 

1. Minor manual changes. 

2. The “Gravity” pane functionality was improved: typing on temperature text box 

causes the table with the μw  parameters to scroll to the respective value. 

3. Fixed a bug that under certain circumstances caused the μw  parameter not to 

be properly read from the “Gravity” user interface. 

 

Changes of version 1.2.1 from version 1.1.2 

1. Minor manual corrections. 

2. A misspelled item in the ColloidFit interface was corrected. 

3. The automatic input generating: Auto input generator (multiple X), found in 

the “Simulating tab” was improved in order to produce consistent results.  

4. The problem with projects that could not be reopened because the 

simulations included non-number values (“Infinity” or “NaN”), which cannot be 

displayed was fixed. Such results are now substituted by zero “0”, along with 

a warning message in the “System output” table. 

5. Small changes were made in the “Pest configuration” file. It is now possible 

for parameters to obtain negative values during the fitting processes, 

assuming that the imposed boundaries allow it.  

6. The manual was revised to include an explanation that the “Absolute 

simulation accuracy” cannot be set to zero for attachment equations. An 

appropriate warning was added in the interface. 

7. The inability to change the number of decimal places of a particular 

mathematical format (i.e. “Exponential” format), without changing the 

mathematical format, was fixed. 

8. Numerical errors that may occur during simulation time will now be reported 

to the user. 

9. Fixed occurrences where the y-axis is pushed away from the respective 

border due to an internal java glitch that rounds up numerical values after it 

has rendered them on screen 
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Changes of version 1.1.2 from version 1.1.1 

1. Minor manual changes 

2. Added extended explanations on virus and colloidal transport models 

3. The initial condition assumed by the attachment models solver is now 

documented in manual. 

 

Changes of version 1.1.1 from version 1.0.1 

1. Additional system checking was added to make sure that boundaries and the 

initial main parameter values are in agreement. 

2. New colloid simulation models were added.  The new models support strictly 

reversible attachment. 

3. The error output system is now reporting more accurately which parameters 

were found to be incorrectly initialized (i.e. empty, negative, non numerical…). 

4. Several minor visual changes in the system options menu. 
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9. Notation 
A             cross-sectional area of the porous medium (column), L2          

Ac          cross-sectional area of the porous medium (column), L2 

b ratio of average free settling segment length to the grain radius, (–) 
Cc concentration of suspended colloids, Mc/L3. 

 constant injected concentration of suspended colloid particles, M/L3 

 constant injected concentration of suspended virus particles, M/L3 

 concentration of colloids  attached onto the solid matrix, Mc/Ms. 

Cv concentration of suspended viruses, Mv/L3. 
 concentration of viruses attached onto the solid matrix, Mv/Ms. 

  concentration of colloids irreversibly attached onto the solid matrix,  Mc/Ms. 

  concentration of colloids reversibly attached onto the solid matrix,  Mc/Ms. 

dp colloid particle diameter, L 
Dc   hydrodynamic dispersion coefficient of colloids, L2/t. 
Dv  hydrodynamic dispersion coefficient of viruses, L2/t. 
Dx  hydrodynamic dispersion coefficient of colloids or viruses, L2/t. 
fs                   settling velocity correction factor, (–) 
g gravitational acceleration, L/t2.  
g(i) vector component of gravitational acceleration in the positive x-direction, L/t2.  
g(-i) vector component of gravitational acceleration in the negative x-direction, L/t2.  
g(-k) vector component of gravitational acceleration in the negative z-direction, L/t2.  

i   species c=colloid, v=virus. 

kirr                   rate coefficient of irreversible colloid attachment onto the sold matrix, 1/t. 

Min          injected mass, M. 

Mr            mass recovery ratio, (-) 

Mδ             mass injected “instantaneously” over the porous medium cross-sectional area, M/L2  

mn             n-th absolute temporal moment, TnM/L3 

Mn             n-th normalized temporal moment, Tn 

Mc  mass of colloids, Mc. 
Ms  mass of the solid matrix, Ms. 
Mv      mass of viruses, Mv.  
r1                   rate coefficient of colloid or virus attachment onto the sold matrix (see table 4.5), 1/t. 
r2                   rate coefficient of colloid or virus  detachment from the solid matrix (see table 4.5), 1/t. 

       rate coefficient of irreversible colloid attachment onto the sold matrix, 1/t.
 

         rate coefficient of reversible colloid attachment onto the sold matrix, 1/t. 

       rate coefficient of reversible colloid detachment from the solid matrix, 1/t. 

         rate coefficient of virus attachment onto the solid matrix, 1/t. 

        rate coefficient of virus detachment from the solid matrix, 1/t. 

t              time, t. 
tp             time period during of which the source has a constant concentration, t. 
U             interstitial velocity n, L/t. 
Utot          total velocity (sum of average interstitial velocity with settling velocity), L/t. 
Ueff          total velocity (sum of average interstitial velocity with settling velocity) (see table 4.5), 

L/t. 
Us(±i) x-directional component of the restricted settling velocity of species i, L/t. 
x  Cartesian coordinate in the longitudinal direction, L. 
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Greek Letters  
  angle of the main flow direction (x-direction) with respect to the direction of gravity. 

 empirical correction factor, (–) 
  modified Dirac delta function, 1/L. 
 θ porosity of the column material, (L3 voids)/(L3 solid matrix). 

w dynamic viscosity of water, M/(L·t) 

 
decay rate of viruses suspended in the liquid phase, 1/t. 

 
decay rate of viruses sorbed or attached onto the solid matrix, 1/t. 

 λ
 

decay rate of particles suspended in the liquid phase (see table 4.5), 1/t. 
 λ*

 
decay rate of particles sorbed or attached onto the solid matrix (see table 4.5), 1/t. 

b bulk density of the solid matrix, Ms/L3. 

p particle density, M/L3 

w fluid density, M/L3 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



56 
 

ColloidFit: User Manual v.1.3.1 (November 2019) 

10. References 
 

Abramowitz, M., and I.A. Stegun, Handbook of Mathematical Functions with Formulas, 

Graphs, and Mathematical Tables, National Bureau of Standards, 1046 pp., 1964. 

Chrysikopoulos, C.V., and V.E. Katzourakis, Colloid particle size-dependent 

dispersivity, Water Resources Research, 51, 4668–4683, doi:10.1002/2014WR016094, 

2015.  

Chrysikopoulos, C.V., and V.I. Syngouna. Effect of gravity on colloid transport through water-

saturated columns packed with glass beads: Modeling and experiments, Environmental 

Science and Technology, 48, 6805-6813, doi:10.1021/es501295n, 2014. 

Compere F, Porel G, Delay F. Transport and retention of clay particles in saturated porous 

media: influence of ionic strength and pore velocity, J Contam Hydrol, 49:1–21, 2001. 

Doherty, J., PEST: Software for model-independent parameter estimation, Watermark 

Numerical Computing, Australia, 2005. 

Hindmarsh, A.C., ODEPACK. A systematized collection of OD solvers, in scientific computing, 

R.S. Stepleman et al. (Eds.), North-Holland, Amsterdam, pp. 55–64. 1983. 

James, S.C., and C.V. Chrysikopoulos. Monodisperse and polydisperse colloid transport in 

water-saturated fractures with various orientations: Gravity effects, Adv. Water Resour., 

34, 1249–1255, doi:10.1016/j.advwatres.2011.06.001, 2011. 

Katzourakis, V.E., and C.V. Chrysikopoulos. Mathematical modeling of colloid and virus 

cotransport in porous media: Application to experimental data, Adv. Water Resour., 68, 

62–73, doi:10.1016/j.advwatres.2014.03.001, 2014.   

Katzourakis, V.E., and C.V. Chrysikopoulos. Modeling dense-colloid and virus cotransport in 

three-dimensional porous media, J. Contam. Hydrol., 181, 102–113, 

doi:10.1016/j.jconhyd.2015.05.010, 2015. 

Petzold, L.R. Automatic selection of methods for solving stiff and nonstiff systems of ordinary 

differential equations, Siam J. Sci. Stat. Comput., 4 136–148, 1983. 

Piessens, R., E. de Doncker-Kapenga, C.W. Überhuber, and D. Kahaner, QUADPACK: A 

subroutine package for automatic integration, Springer-Verlag, 1983. 

Russel, W.B., D.A. Saville, and W.R. Schowlter, Colloidal Dispersions, Cambridge University   

Press, Cambridge, UK, 525 pp., 1989. 

Sim, Y., and C.V. Chrysikopoulos. Analytical solutions for solute transport in saturated porous 

media with semi-infinite or finite thickness, Adv. Water Resour., 22(5), 507–519, 

doi:10.1016/S0309-1708(98)00027-X, 1999. 

Sim, Y., and C.V. Chrysikopoulos. Three-dimensional analytical models for virus transport in 

saturated porous media, Transp. Porous Med., 30, 87–112, 

doi:10.1023/A:1006596412177, 1998. 

Sim, Y., Chrysikopoulos, C.V. Analytical models for one-dimensional virus transport in   

saturated porous media, Water. Resour. Res., 31,1429–1437, 1995. (Correction, Water   

Resour. Res., 32, 1473, 1996). 

Thomas, J.M., and C.V. Chrysikopoulos. Experimental investigation of acoustically enhanced 

colloid transport in water-saturated packed columns, J. Colloid Interface Sci., 308, 200-

207, doi:10.1016/j.jcis.2006.12.062, 2007. 

Wan, J., T. Tokunaga, and C. Tsang. Bacterial sedimentation through a porous medium, 

Water Resour. Res., 31(7), 1627–1636, 1995. 

 

 

 

 

 

https://en.wikipedia.org/wiki/Springer-Verlag


57 
 

ColloidFit: User Manual v.1.3.1 (November 2019) 

11. Web links 
 

ColloidFit official homepage: http://tuceel.tuc.gr/ 

Pest homepage: http://www.pesthomepage.org/ 

Java homepage: https://www.oracle.com/java/index.html 

JavaFx license: http://www.oracle.com/technetwork/java/javase/terms/license/index.html 

GNU Fortran compiler, gFortran homepage: https://gcc.gnu.org/wiki/GFortran 

GNU General Public License: https://gcc.gnu.org/onlinedocs/gfortran/Copying.html#Copying 
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